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Getting Started

Adobe Flash Professional CC provides a comprehensive authoring environ-
ment for creating interactive and media-rich applications. Flash is widely 
used to create engaging projects integrating video, sound, graphics, and 
animation. You can create original content in Flash or import assets from 
other Adobe applications such as Photoshop or Illustrator, quickly design 
animation and multimedia, and use Adobe ActionScript 3.0 to integrate 
sophisticated interactivity.

Use Flash Professional to build innovative and immersive Web sites, to create 
standalone applications for the desktop, or to create apps to distribute to 
mobile devices running on the Android or the iOS system.

With extensive controls for animation, intuitive and flexible drawing tools, 
and a powerful, object-oriented coding language, Flash delivers one of the few 
robust authoring environments that let your imagination become reality. 

About Classroom in a Book
Adobe Flash Professional CC Classroom in a Book is part of the official training 
series for Adobe graphics and publishing software developed with the sup-
port of Adobe product experts. The lessons are designed so you can learn at 
your own pace. If you’re new to Flash, you’ll learn the fundamental concepts 
and features you’ll need to use the program. Classroom in a Book also teaches 
many advanced features, including tips and techniques for using the latest ver-
sion of this application.



2  Getting Started

What’s New
The lessons in this book provide opportunities to use some of the updated features 
and improvements in Flash Professional, including:

•	 A fresh, modern user interface

•	 Working in full-screen mode

•	 Distributing symbols and bitmaps to keyframes

•	 Swapping multiple symbols or bitmaps

•	 A powerful Find and Replace panel

•	 Improved Photoshop and Illustrator file import

•	 A re-engineered Actions panel

•	 Smoother, more responsive drawing and editing

•	 Exporting videos with Adobe Media Encoder

•	 Resizing the Stage relative to an anchor point

•	 An integrated Toolkit for CreateJS, which publishes animation to HTML5 
and JavaScript

•	 Comprehensive testing tools, such as device testing via USB and SWF analysis 
with Adobe Scout

•	 Synchronizing preferences on multiple machines with Creative Cloud

Streamlined Feature Set
In order to provide a more focused creative environment, Adobe Flash Professional 
CC has streamlined its feature set. The following is a list of the notable tools that 
have been dropped from the previous version:

•	 Support for ActionScript 1 and 2

•	 TLF text 

•	 Motion Editor for motion tweens

•	 Bone tool for inverse kinematics

•	 Deco tool

•	 Project panel

•	 Printing

•	 Strings panel
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•	 Behaviors panel

•	 Object-level undo

•	 Spelling panel

•	 Movie Explorer

•	 Bandwidth profiler in Test Movie mode

•	 FXG file import or export

•	 Kuler panel

•	 Video Cue Points (but still available in Media Encoder and through ActionScript)

•	 Closed captioning

•	 Video playback on Stage with FLV playback component

•	 Device Central

•	 Importing SWFs

•	 Pick whip in the Code Snippets panel

•	 Auto-Save

•	 File Info (XMP Metadata)

•	 Import support for some bitmap formats (BMP, TIFF, AutoCad) and some 
sound formats (AIFF, Sound Designer, Around AU, Adobe Sounds Document)

•	 Publishing projectors

Prerequisites
Before you begin using Adobe Flash Professional CC Classroom in a Book, make 
sure your system is set up correctly and that you’ve installed the required software. 
You should have a working knowledge of your computer and operating system. You 
should know how to use the mouse and standard menus and commands, and also 
how to open, save, and close files. If you need to review these techniques, see the 
printed or online documentation included with your Microsoft Windows or Apple 
Mac OS software.

If you’re working on Microsoft Windows, you need to download Apple’s 
QuickTime software, free from http://www.apple.com/quicktime/download/ 
in order to work with the videos in Lesson 7.

In addition, you need to download the free Adobe AIR runtime, available at  
http://get.adobe.com/air/ to publish desktop applications in Lesson 11.

http://www.apple.com/quicktime/download/
http://get.adobe.com/air/


4  Getting Started

Installing Flash
You must purchase the Adobe Flash Professional application as part of the Adobe 
Creative Cloud. The following specifications are the minimum required system 
configurations.

Windows

•	 Intel® Pentium 4, Intel Centrino®, Intel Xeon®, or Intel Core™ Duo 
(or compatible) processor

•	 Microsoft® Windows® 7 64-bit and Microsoft® Windows® 8 64-bit

•	 2GB of RAM (4GB recommended)

•	 1024x768 display (1280x800 recommended)

•	 Java Runtime Environment 1.7 (included)

•	 QuickTime 10.x software recommended

•	 2GB of available hard-disk space for installation; additional free space required 
during installation (cannot install on removable flash storage devices)

•	 Broadband Internet connection and registration are necessary for required 
software activation, validation of subscriptions, and access to online services.

Mac OS

•	 Multicore Intel® processor

•	 Mac OS X v10.7 64-bit and 10.8 64-bit

•	 2GB of RAM (4GB recommended)

•	 1024x768 display (1280x800 recommended)

•	 Java™ Runtime Environment 1.7

•	 QuickTime 10.x software recommended

•	 2.5GB of available hard-disk space for installation; additional free space required 
during installation (cannot install on a volume that uses a case-sensitive file 
system or on removable flash storage devices)

•	 Broadband internet connection and registration are necessary for required 
software activation, validation of subscriptions, and access to online services.

For updates on system requirements and complete instructions on installing the 
software, visit http://www.adobe.com/products/flash/tech-specs.html. 

Install Flash from the Adobe Creative Cloud at https://creative.adobe.com/ and 
make sure that you have your login and password accessible.

http://www.adobe.com/products/flash/tech-specs.html
https://creative.adobe.com/
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Copying the Lesson Files
The lessons in Adobe Flash Professional CC Classroom in a Book use specific source 
files, such as image files created in Adobe Illustrator, video files created in Adobe 
After Effects, audio files, and prepared Flash documents. To access the Classroom 
in a Book files:

1	 On a Mac or PC, go to www.peachpit.com/redeem and enter the code found at 
the back of your book.

2	 If you do not have a Peachpit.com account, you will be prompted to create one.

3	 The downloadable files will be listed under Lesson & Update Files tab on your 
Account page. 

4	 Click the lesson file links to download them to your computer.

5	 On your hard drive, create a new folder in a convenient location and name it 
FlashProCC, following the standard procedure for your operating system:

•	 If you’re running Windows, right-click and choose New > Folder. Then enter 
the new name for your folder.

•	 If you’re using Mac OS, in the Finder, choose File > New Folder. Type the 
new name and drag the folder to the location you want to use.

Now you can download the lesson files onto your hard drive.

6	 Drag the Lessons folder (which contains folders named Lesson01, Lesson02, 
and so on) that you downloaded onto your hard drive to your new 
FlashProCC folder.

When you begin each lesson, navigate to the folder with that lesson number to access 
all the assets, sample movies, and other project files you need to complete the lesson.

If you have limited storage space on your computer, you can copy each lesson 
folder as you need it, and then delete it after you’ve completed the lesson if desired. 
Some lessons build on preceding lessons; in those cases, a starting project file is 
provided for you for the second lesson or project. You do not have to save any fin-
ished project if you don’t want to or if you have limited hard drive space.

Copying the sample movies and projects
You will create and publish SWF animation files in some lessons in this book. 
The files in the End folders (01End, 02End, and so on) within the Lesson folders are 
samples of completed projects for each lesson. Use these files for reference if you 
want to compare your work in progress with the project files used to generate the 
sample movies. The end project files vary in size from relatively small to a couple of 
megabytes, so you can either copy them all now if you have ample storage space or 
copy just the end project file for each lesson as needed. Then you can delete it when 
you finish that lesson.

http://www.peachpit.com/redeem
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How to Use the Lessons
Each lesson in this book provides step-by-step instructions for creating one or 
more specific elements of a real-world project. Some lessons build on projects 
created in preceding lessons; most stand alone. All the lessons build on one 
another in terms of concepts and skills, so the best way to learn from this book is 
to proceed through the lessons in sequential order. In this book, some techniques 
and processes are explained and described in detail only the first few times you 
perform them. 

The organization of the lessons is also project-oriented rather than feature-oriented. 
That means, for example, that you’ll work with symbols on real-world design projects 
over several lessons rather than in just one chapter. 

Additional Resources
Adobe Flash Professional CC Classroom in a Book is not meant to replace docu-
mentation that comes with the program or to be a comprehensive reference for 
every feature. Only the commands and options used in the lessons are explained in 
this book. For comprehensive information about program features and tutorials, 
refer to these resources:

Adobe Flash Professional CC Help and Support: www.adobe.com/support/flash 
is where you can find and browse Help and Support content on Adobe.com. 
Adobe Flash Professional Help and Adobe Flash Professional Support Center are 
accessible from Flash Professional’s Help menu.

Adobe Creative Cloud Learning: For inspiration, key techniques, cross-product 
workflows, and updates on new features, go to the Creative Cloud Learn page 
https://helpx.adobe.com/creative-cloud/tutorials.html. Available only to Creative 
Cloud members.

Adobe Forums: forums.adobe.com lets you tap into peer-to-peer discussions, 
questions, and answers on Adobe products. The Flash Professional forum is acces-
sible from Flash Professional’s Help menu.

Adobe TV: tv.adobe.com is an online video resource for expert instruction and 
inspiration about Adobe products, including a How To channel to get you started 
with your product.

Adobe Design Center: www.adobe.com/designcenter offers thoughtful articles 
on design and design issues, a gallery showcasing the work of top-notch designers, 
tutorials, and more.

http://www.adobe.com/support/flash
https://helpx.adobe.com/creative-cloud/tutorials.html
http://www.adobe.com/designcenter
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Resources for educators: www.adobe.com/education and http://edex.adobe.com 
offer a treasure trove of information for instructors who teach classes on Adobe 
software. Find solutions for education at all levels, including free curricula that use 
an integrated approach to teaching Adobe software and can be used to prepare for 
the Adobe Certified Associate exams.

Also check out these useful links:

Adobe Marketplace & Exchange: www.adobe.com/cfusion/exchange is a central 
resource for finding tools, services, extensions, code samples, and more to supple-
ment and extend your Adobe products.

Adobe Flash Professional CC product home page: www.adobe.com/products/
flash

Adobe Labs: labs.adobe.com gives you access to early builds of cutting-edge tech-
nology, as well as forums where you can interact with both the Adobe development 
teams building that technology and other like-minded members of the community.

Adobe Certification
The Adobe training and certification programs are designed to help Adobe 
customers improve and promote their product-proficiency skills. There are four 
levels of certification:

•	 Adobe Certified Associate (ACA)

•	 Adobe Certified Expert (ACE)

•	 Adobe Certified Instructor (ACI)

•	 Adobe Authorized Training Center (AATC)

The Adobe Certified Associate (ACA) credential certifies that individuals have the 
entry-level skills to plan, design, build, and maintain effective communications 
using different forms of digital media.

The Adobe Certified Expert program is a way for expert users to upgrade their 
credentials. You can use Adobe certification as a catalyst for getting a raise, finding 
a job, or promoting your expertise.

If you are an ACE-level instructor, the Adobe Certified Instructor program takes your 
skills to the next level and gives you access to a wide range of Adobe resources.

Adobe Authorized Training Centers offer instructor-led courses and training 
on Adobe products, employing only Adobe Certified Instructors. A directory of 
AATCs is available at partners.adobe.com.

For information on the Adobe Certified programs, visit www.adobe.com/support/
certification/main.html.

http://www.adobe.com/education
http://edex.adobe.com
http://www.adobe.com/cfusion/exchange
http://www.adobe.com/products/
http://www.adobe.com/support/certification/main.html
http://www.adobe.com/support/certification/main.html
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Animating Symbols

Lesson Overview
In this lesson, you’ll learn how to do the following:

•	 Animate the position, scale, and rotation of objects

•	 Adjust the pacing and timing of your animation

•	 Animate transparency and special effects

•	 Change the path of an object’s motion

•	 Create animation inside symbols

•	 Split a motion tween

•	 Change the easing of an object’s motion

•	 Animate in 3D space

This lesson will take approximately 2 hours to complete. If needed, remove 
the previous lesson folder from your hard drive and copy the Lesson04 
folder onto it. Download the project files for this lesson from the Lesson & 
Update Files tab on your Account page at www.peachpit.com and store 
them on your computer in a convenient location, as described in the 
Getting Started section of this book. Your Accounts page is also where 
you’ll find any updates to the chapters or to the lesson files. Look on the 
Lesson & Update Files tab to access the most current content.

4

http://www.peachpit.com
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Use Flash Professional to change almost any aspect of 
an object—position, color, transparency, size, rotation, 
and more—over time. Motion tweening is the basic 
technique of creating animation with symbol instances.
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Getting Started
Start by viewing the finished movie file to see the animated title page that you’ll 
create in this lesson. 

1	 Double-click the 04End.html file in the Lesson04/04End folder to play the 
animation in a browser.

The project is an animated splash page for an imaginary soon-to-be-released 
motion picture. In this lesson, you’ll use motion tweens to animate several 
components on the page: the cityscape, the main actors, several old-fashioned 
cars, and the main title.

2	 Close the 04End.html file.

3	 Double-click the 04Start.fla file in the Lesson04/04Start folder to open the initial 
project file in Flash. This file is partially completed and already contains many of 
the graphic elements imported into the Library for you to use.

4	 From the view options above the Stage, choose Fit in Window, or View > 
Magnification > Fit in Window so that you can see the entire Stage on your 
computer screen.

5	 Choose File > Save As. Name the file 04_workingcopy.fla, and save it in the 
04Start folder. 

Saving a working copy ensures that the original start file will be available if you 
want to start over. 

P	Note:  If you have 
not already downloaded 
the project files for this 
lesson to your computer 
from your Account page, 
make sure to do so now. 
See “Getting Started” 
at the beginning of 
the book.



Adobe Flash Professional CC Classroom in a Book  109

About Animation
Animation is the movement, or change, of objects through time. Animation can be 
as simple as moving a box across the Stage from one frame to the next. It can also 
be much more complex. As you’ll see in this lesson, you can animate many different 
aspects of a single object. You can change an object’s position on the Stage, change 
its color or transparency, change its size or its rotation, and even animate the special 
filters that you saw in the previous lesson. You also have control over an object’s path 
of motion, and even its easing, which is the way an object accelerates or decelerates.

In Flash, the basic workflow for animation goes like this: Select an object on the 
Stage, right-click/Ctrl-click, and choose Create Motion Tween. Move the red play-
head to a different point in time and move the object to a new position or change 
one of its properties. Flash takes care of the rest.

Motion tweens create animation for changes in position on the Stage and for 
changes in size, color, or other attributes. Motion tweens require you to use a 
symbol instance. If the object you’ve selected is not a symbol instance, Flash will 
automatically ask to convert the selection to a symbol. 

Flash also automatically separates motion tweens on their own layers, which are called 
Tween layers. There can be only one motion tween per layer without any other ele-
ment in the layer. Tween layers allow you to change various attributes of your instance 
at different key points over time. For example, a spaceship could be on the left side of 
the Stage at the beginning keyframe and at the far-right side of the Stage at an ending 
keyframe, and the resulting tween would make the spaceship fly across the Stage.

The term “tween” comes from the world of classic animation. Senior animators would 
be responsible for drawing the beginning and ending poses for their characters. The 
beginning and ending poses were the keyframes of the animation. Junior animators 
would then come in and draw the “in-between” frames, or do the “in-betweening.” 
Hence, “tweening” refers to the smooth transitions between keyframes.

Understanding the Project File
The 04Start.fla file contains a few of the animated elements already or partially 
completed. Each of the six layers—man, woman, Middle_car, Right_car, footer, and 
ground—contains an animation. The man and woman layers are in a folder called 
actors, and the Middle_car and Right_car layers are in a folder called cars. 
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You’ll be adding more layers to add an animated 
cityscape, refining the animation of one of the actors, as 
well as adding a third car and a 3D title. All the necessary 
graphic elements have been imported into the Library 
panel. The Stage is set at a generous 1280 pixels by 787 
pixels, and the Stage color is black. You might need to 
choose a different view option to see the entire Stage. 
Choose View > Magnification > Fit in Window, or choose 
Fit in Window from the view options at the top-right 
corner of the Stage to view the Stage at a magnification 
percentage that fits your screen. 

Animating Position
You’ll start this project by animating the 
cityscape. It will begin slightly lower than the top 
edge of the Stage, and then rise slowly until its top 
is aligned with the top of the Stage.

1	 Lock all the existing layers so you don’t 
accidentally modify them. Create a new layer 
above the footer layer and rename it city.

2	 Drag the bitmap image called cityBG.jpg from 
the bitmaps folder in the Library panel to the Stage.
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3	 In the Properties inspector, set the value of X to 0 and the value of Y to 90.

This positions the cityscape image just slightly below the top edge of the Stage.

4	 Right-click/Ctrl-click on the cityscape image and choose Create Motion Tween. 
From the top menu, you can also select Insert > Motion Tween.

5	 A dialog box appears warning you that your selected object is not a symbol. 
Motion tweens require symbols. Flash asks if you want to convert the selection 
to a symbol so it can proceed with the motion tween. Click OK.

Flash automatically converts your selection to a symbol, which is stored in your 
Library panel. Flash also converts the current layer to a Tween layer so you 
can begin to animate the instance. Tween layers are distinguished by a special 
icon in front of the layer name, and the frames are tinted blue. Tween layers are 
reserved for motion tweens, and hence, no drawing is allowed on a Tween layer.
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6	 Move the red playhead to the end of the tween span at frame 190.

7	 Select the instance of the cityscape on the Stage, and while holding down the 
Shift key, move the instance up the Stage.

Holding down the Shift key constrains the movement to right angles.

8	 For more precision, set the value of Y to 0 in the Properties inspector.

A small black diamond appears in frame 190 at the end of the tween span. This 
indicates a keyframe at the end of the tween.

Flash smoothly interpolates the change in position from frame 1 to frame 190 
and represents that motion with a motion path.

9	 Drag the red playhead back and forth at the top of the Timeline to see the 
smooth motion. You can also choose Control > Play (Enter) to make Flash play 
the animation.

Animating changes in position is simple, because Flash automatically creates 
keyframes at the points where you move your instance to new positions. If you 
want to have an object move to many different points, simply move the red 
playhead to the desired frame, and then move the object to its new position. 
Flash takes care of the rest.

P	Note:  Hide all the 
other layers to isolate 
the cityscape and to 
better see the results 
of the motion tween.

P	Note:  Remove a 
motion tween by right-
clicking/Ctrl-clicking 
the motion tween on 
the Timeline or the 
Stage and choosing 
Remove Tween.
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Using the Controller to preview the animation
The Controller panel allows you to play, rewind, or go step-by-step backward or 
forward through your Timeline to review your animation in a controlled manner.

Use the playback controls that are integrated at the bottom of the Timeline, 
or choose the playback commands from the Control menu.

1	 Click any of the playback buttons on the controller below the Timeline to go to 
the first frame, go to the last frame, play, stop, or move forward or backward 
one frame. 

2	 Choose the loop option at the bottom of the Timeline and click the play button.

The playhead loops, allowing you to see the animation over and over for 
careful analysis.

3	 Move the front or rear brackets on the Timeline to define the range of frames 
that you want to see looped.

The playhead loops within the bracketed frames. Click on the loop option again 
to turn it off.

Changing the Pacing and Timing
You can change the duration of the entire tween span or change the timing of the 
animation by clicking and dragging keyframes on the Timeline.

Changing the animation duration
If you want the animation to proceed at a slower pace (and hence, taking up a 
much longer period of time), you need to lengthen the entire tween span between 
the beginning and end keyframes. If you want to shorten the animation, you need 
to decrease the tween span. Lengthen or shorten a motion tween by dragging the 
ends on the Timeline.



114  Lesson 4  Animating Symbols

1	 Move your mouse cursor close to the end of the tween span in the city layer.

Your cursor changes to a double-headed arrow, indicating that you can lengthen 
or shorten the tween span.

2	 Click and drag the end of the tween span back toward frame 60.

Your motion tween shortens to 60 frames, so now the cityscape takes a much 
shorter time to move. 

3	 Move your mouse cursor close to the beginning of the tween span (at frame 1).

4	 Click and drag the beginning of the frame span forward to frame 10.

Your motion tween begins at an earlier time, so it now plays only from frame 10 
to frame 60. 

P	Note:  If you have 
multiple keyframes 
in a tween, dragging 
out your tween spans 
will distribute all your 
keyframes uniformly. 
The timing of your 
entire animation 
remains the same; only 
the length changes.
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Adding frames
You’ll want the last keyframe of your motion tween to hold for the remainder of the 
animation. Add frames by Shift-dragging the end of a tween span.

1	 Move your mouse cursor close to the end of the tween span.

2	 Hold down the Shift key, and click and drag the end of the tween span forward 
to frame 190.

The last keyframe in the motion tween remains at frame 60, but additional 
frames are added to frame 190.

Moving keyframes
If you want to change the pacing of an animation, you can select individual 
keyframes, then click and drag the keyframes to new positions. 

1	 Click on the keyframe at frame 60.

The keyframe at frame 60 is selected. A tiny box appears 
next to your mouse cursor indicating that you can move 
the keyframe.

2	 Click and drag the keyframe to frame 40.

The last keyframe in the motion tween moves to frame 40, 
so the motion of the cityscape proceeds quicker.

P	Note:  You can also 
add individual frames 
by choosing Insert > 
Timeline > Frame (F5), 
or remove individual 
frames by choosing 
Edit > Timeline > 
Remove Frames 
(Shift+F5).



116  Lesson 4  Animating Symbols

Span-Based vs. Frame-Based  
Selections
By default, Flash does not use span-based selection, 
which means you can select individual keyframes 
within a motion tween. However, if you prefer to 
click on a motion tween and have the entire span 
(the beginning and end keyframes, and all the 
frames in between) be selected, you can enable 
Span Based Selection from the Options menu on the 
top-right corner of the Timeline.

With Span Based Selection enabled, you can click 
anywhere within the motion tween to select it, and 
move the whole animation backward or forward 
along the Timeline as a single unit.

If you want to select individual keyframes while Span Based Selection is enabled, 
hold down the Ctrl (Windows)/Command (Mac OS) key and click on a keyframe.

Animating Transparency
In the previous lesson, you learned how to change the color effect of any symbol 
instance to change the transparency, tint, or brightness. You can change the color 
effect of an instance in one keyframe and change the value of the color effect in 
another keyframe, and Flash will automatically display a smooth change, just as it 
does with changes in position.

You’ll change the cityscape in the beginning keyframe to be totally transparent 
but keep the cityscape in the ending keyframe opaque. Flash will create a smooth 
fade-in effect.

1	 Move the red playhead to the first keyframe of the motion tween (frame 10).
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2	 Select the cityscape instance on the Stage.

3	 In the Properties inspector, choose the Alpha option for Color Effect.

4	 Set the Alpha value to 0%.

The cityscape instance on the Stage becomes totally transparent.

5	 Move the red playhead to the last keyframe of the motion tween (frame 40).

6	 Select the cityscape instance on the Stage.
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7	 In the Properties inspector, under Color Effect, set the Alpha value to 100%.

The cityscape instance on the Stage becomes totally opaque.

8	 Preview the effect by choosing Control > Play (Enter).

Flash interpolates the changes in both position and transparency between the 
two keyframes.

Animating Filters
Filters, which give instances special effects such as blurs and drop shadows, can 
also be animated. You’ll refine the motion tween of the actors next by apply-
ing a blur filter to one of them to make it appear as if the camera changes focus. 
Animating filters is no different from animating changes in position or changes in 
color effect. You simply set the values for a filter at one keyframe and set different 
values for the filter at another keyframe, and Flash creates a smooth transition.

1	 Make the actors layer folder on the Timeline visible.

2	 Lock all the layers on the Timeline except the woman layer.

3	 Move the red playhead to the beginning keyframe of the motion tween in the 
woman layer—at frame 23.
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4	 Select the instance of the woman on the Stage. You won’t be able to see her 
because she has an alpha value of 0% (totally transparent), but if you click on the 
top-right side of the Stage, the transparent instance will be selected.

5	 In the Properties inspector, expand the Filters section.

6	 Click the Add filter button at the top of the Filters section and select Blur.

Flash applies the Blur filter to the instance.

7	 In the Filters section of the Properties inspector, make sure that the link icons 
are intact to constrain the blur values to both the x and y directions equally. 
Set the X and Y Blur values to 20 pixels.
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8	 Move the red playhead across the entire Timeline to preview the animation.

The 20-pixel Blur filter is applied to the woman instance throughout the 
motion tween.

9	 Right-click/Ctrl-click on the woman layer at frame 140, and choose Insert 
Keyframe > Filter.

A keyframe for filters is established at frame 140.

10	Move the red playhead to frame 160, and right-click/Ctrl-click on the woman 
layer and choose Insert Keyframe > Filter.

Another keyframe for filters is established at frame 160.

11	Select the instance of the woman on the Stage at frame 160.



Adobe Flash Professional CC Classroom in a Book  121

12	 In the Properties inspector, change the value of the Blur filter to X=0 and Y=0.

The Blur filter changes from the keyframe at frame 140 to the keyframe at 160. 
Flash creates a smooth transition from a blurry instance to an in-focus instance.

Understanding Property Keyframes 
Changes in properties are inde-
pendent of one another and do 
not need to be tied to the same 
keyframes. That is, you can have 
a keyframe for position, a different 
keyframe for the color effect, and 
yet another keyframe for a filter. 
Managing many different kinds of 
keyframes can become overwhelm-
ing, especially if you want different 
properties to change at different times during the motion tween. Fortunately, Flash 
Professional provides a few helpful tools for keyframe management.

When viewing the tween span, you can choose to view the keyframes of only certain 
properties. For example, you can choose to view only the Position keyframes to see 
when your object moves. Or, you can choose to view only the Filter keyframes to see 
when there is a filter change. Right-click/Ctrl-click on a motion tween in the Timeline, 
choose View Keyframes, and then select the desired property among the list. You can 
also choose All or None to see all the properties or none of the properties.

When inserting a keyframe, you can also insert a keyframe specific to the property 
you want to change. Right-click/Ctrl-click on a motion tween in the Timeline, choose 
Insert Keyframes, and then select the desired property.
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Animating Transformations
Now you’ll learn how to animate changes in scale or rotation. These kinds of 
changes are made with the Free Transform tool or with the Transform panel. 
You’ll add a third car to the project. The car will start small, and then become 
larger as it appears to move forward toward the viewer.

1	 Lock all the layers on the Timeline.

2	 Insert a new layer inside the Cars folder and rename it Left_car. 

3	 Select frame 75 and insert a new keyframe (F6).

4	 Drag the movie clip symbol called carLeft from the Library panel to the Stage at 
frame 75.

5	 Select the Free Transform tool.

The transformation handles appear around the instance on the Stage.
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6	 While holding down the Shift key, click and drag a corner handle inward 
to make the car smaller.

7	 In the Properties inspector, make sure that the width of the car is about 
400 pixels.

8	 Alternatively, you can use the Transform panel (Window > Transform) and 
change the scale of the car to about 29.4%.

9	 Move the car to its starting position at about X=710 and Y=488.

10	 In the Properties inspector, select Alpha for the Color Effect.

11	Set the value of the Alpha to 0%.

The car becomes totally transparent.

12	Right-click/Ctrl-click on the car on the Stage and select Create Motion Tween.

The current layer becomes a Tween layer.
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13	Move the red playhead on the Timeline to frame 100.

14	Select the transparent instance of the car on the Stage, and in the Properties 
inspector, change the Alpha value to 100%.

A new keyframe is automatically inserted at frame 100 to indicate the change 
in transparency.

15	Select the Free Transform tool.

16	While holding down the Shift key, click and drag a corner handle outward to 
make the car larger. For more precision, use the Properties inspector and set the 
dimensions of the car to width=1380 pixels and height=445.05 pixels.

17	Position the car at X=607 and Y=545.

18	Move the Left_car layer in between the Middle_car and Right_car layers so that 
the car in the center overlaps the cars on the side.

P	Note:  Hold down 
the Alt (Windows)/
Option (Mac OS) key 
while you drag the 
corner handle of the 
Transformation tool 
to change the scale 
relative to the opposite 
corner point.
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Flash tweens the change in position and the change in scale from frame 
75 to frame 100. Flash also tweens the change in transparency from  
frame 75 to frame 100.

Motion Presets
If your project involves creating identical motion tweens repeatedly, 
Flash provides a panel called Motion Presets that can help. The Motion 
Presets panel (Window > Motion Presets) can store any motion tween 
so you can apply it to different instances on the Stage.

For example, if you want to build a slide show where each image fades 
out in the same manner, you can save that transition to the Motion 
Presets panel. 

1	 Select the first motion tween on the Timeline or the instance on 
the Stage.

2	 In the Motion Presets panel, click the Save selection as preset button 
at the bottom of the panel.

3	 Name your motion preset, and it will be saved in the Motion 
Presets panel.

4	 Select a new instance on the Stage and choose the motion preset.

5	 Click Apply, and Flash will apply your saved motion preset to the new instance.

Flash provides a number of motion presets that you can use to quickly build sophisticated animations without 
much effort. 
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Changing the Path of the Motion
The motion tween of the left car that 
you just animated shows a colored line 
with dots indicating the path of the 
motion. The path of the motion can 
be edited easily so that the car travels 
in a curve, or the path can be moved, 
scaled, or even rotated just like any 
other object on the Stage. 

To better demonstrate how you can 
edit the path of the motion, open the 
sample file 04MotionPath.fla. The file 
contains a single Tween layer with a 
rocket ship moving from the top left 
of the Stage toward the bottom right.

Moving the path of the motion
You will move the path of the motion so the relative movement of the rocket ship 
remains the same, but its starting and ending positions change.

1	 Choose the Selection tool.

2	 Click on the path of the motion to select it.

The path of the motion becomes highlighted when 
it is selected.

3	 Click and drag the motion path to move it to a 
different place on the Stage.

The relative motion and timing of the animation 
remain the same, but the starting and ending 
positions are relocated.
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Changing the scale or rotation of the path
You can also manipulate the path of the object’s motion using the Free 
Transform tool.

1	 Select the path of the motion.

2	 Choose the Free Transform tool.

Transformation handles appear around the path of the motion.

3	 Scale or rotate the path of the motion as desired. You can make the path smaller 
or larger, or rotate the path so the rocket ship starts from the bottom left of the 
Stage and ends at the top right.
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Editing the path of the motion
Making your objects travel on a curved path is a simple matter. You can either edit 
the path with Bezier precision using anchor point handles, or you can edit the path 
in a more intuitive manner with the Selection tool.

1	 Choose the Convert Anchor Point tool, which is hidden under the Pen tool.

2	 Click on the starting point or the ending point of the motion path on the Stage 
and drag the control handle out from the anchor point.

The handle on the anchor point controls the curvature of the path.

3	 Choose the Subselection tool.

4	 Click and drag the handle to edit the curve of the path. Make the rocket ship 
travel in a wide curve.

P	Note:  You can also 
directly manipulate 
the path of the motion 
with the Selection tool. 
Choose the Selection 
tool and move it close 
to the path of the 
motion. A curved icon 
appears next to your 
cursor indicating that 
you can edit the path. 
Click and drag the path 
of the motion to change 
its curvature. 
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Orienting objects to the path
Sometimes the orientation of the object traveling along the path is important. 
In the motion picture splash page project, the orientation of the car is constant 
as it rumbles forward. However, in the rocket ship example, the rocket ship 
should follow the path with its nose pointed in the direction in which it is heading. 
The Orient to path option in the Properties inspector gives you this option.

1	 Select the motion tween on the Timeline.

2	 In the Properties inspector, under Rotation, select the Orient to path option.

Flash inserts keyframes for rotation along the motion tween so that the nose 
of the rocket ship is oriented to the path of the motion.

Swapping Tween Targets
The motion tween model in Flash Professional is object-based. This means that an 
object and its motion are independent of each other, and you can easily swap out the 
target of a motion tween. If, for example, you’d rather see an alien moving around the 

P	Note:  To direct the 
nose of the rocket ship, 
or any other object, 
along the path of its 
motion, you must 
orient its position so 
that it is facing in the 
direction that you want 
it to travel. Use the 
Free Transform tool to 
rotate its initial position 
so that it is oriented 
correctly.
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Stage instead of a rocket ship, you can replace the target of the motion tween with an 
alien symbol from your Library panel and still preserve the animation.

1	 Drag the movie clip symbol of the alien from the Library panel onto the 
rocket ship.

2	 Flash asks if you want to replace the existing tween target object with a new object.

3	 Click OK.

Flash replaces the rocket ship with the alien. The motion remains the same, 
but the target of the motion tween has changed.

P	Note:  You can also swap instances in the Properties 
inspector. Select the object that you want to swap on the 
Stage. In the Properties inspector, click the Swap button. In 
the dialog box that appears, choose a new symbol and click 
OK. Flash will swap the target of the motion tween.
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Creating Nested Animations
Often, an object that is animated on the Stage will have its own animation. For 
example, a butterfly moving across the Stage will have an animation of its wings 
flapping as it moves. Or the alien that you swapped with the rocket ship could be 
waving his arms. These kinds of animations are called nested animations, because 
they are contained inside the movie clip symbols. Movie clip symbols have their 
own Timeline that is independent of the main Timeline.

In this example, you’ll make the alien wave his arms inside the movie clip symbol, 
so he’ll be waving as he moves across the Stage.

Creating animations inside movie clip symbols
1	 In the Library panel, double-click the alien movie clip symbol icon.

You are now in symbol-editing mode for the alien movie clip symbol. The alien 
appears in the middle of the Stage. In the Timeline, the parts of the alien are 
separated in layers.

2	 Choose the Selection tool.

3	 Right-click/Ctrl-click on the alien’s left arm and choose Create Motion Tween.
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Flash converts the current layer to a Tween layer and inserts 1-second’s worth 
of frames so you can begin to animate the instance. 

4	 Choose the Free Transform tool.

5	 Drag the corner rotation control points to rotate the arm 
upward to the alien’s shoulder height.

Flash inserts a keyframe at the end of the motion tween. 
The left arm rotates smoothly from the resting position 
to the outstretched position.

6	 Move the red playhead back to frame 1.

7	 Now create a motion tween for the alien’s other arm. Right-click/Ctrl-click on 
his right arm and choose Create Motion Tween.

Flash converts the current layer to a Tween layer and inserts 1-second’s worth 
of frames so you can begin to animate the instance. 

8	 Choose the Free Transform tool.

9	 Drag the corner rotation control points to rotate the arm 
upward to the alien’s shoulder height.

Flash inserts a keyframe at the end of the motion tween. 
The arm rotates smoothly from the resting position to 
the outstretched position.

10	Select the last frame in all the other layers and insert frames (F5) so that the 
head, body, and feet all remain on the Stage for the same amount of time as the 
moving arms.
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11	Exit symbol-editing mode by clicking the Scene 1 button in the Edit Bar at the 
top of the Stage.

Your animation of the alien raising his arms is complete. Wherever you use the 
movie clip symbol, the alien will continue to play its nested animation.

12	Preview the animation by choosing Control > Test Movie > in Flash 
Professional.

Flash opens a window showing the exported animation. The alien moves along 
the motion path while the nested animation of his arms moving plays and loops.

Easing
Easing refers to the way in which a motion tween proceeds. You can think of easing 
as acceleration or deceleration. An object that moves from one side of the Stage 
to the other side can start off slowly, then build up speed, and then stop suddenly. 
Or, the object can start off quickly, and then gradually slow to a halt. Your key-
frames indicate the beginning and end points of the motion, but the easing deter-
mines how your object gets from one keyframe to the next.

You apply easing to a motion tween from the Properties inspector. Easing values 
range from −100 to 100. A negative value creates a more gradual change from the 
starting position (known as an ease-in). A positive value creates a gradual slow-
down (known as an ease-out).

Splitting a motion tween
Easing affects the entire span of a motion tween. If you want the easing to affect 
only frames between keyframes of a longer motion tween, you should split the 
motion tween. For example, return to the 04_workingcopy.fla file of the cinematic 
animation. The motion tween of the car in the Left_car layer begins at frame 75 and 
ends at frame 190, at the very end of the Timeline. However, the actual movement 
of the car starts at frame 75 and ends at frame 100. You’ll split the motion tween so 
you can apply an ease to the tween just from frames 75 to 100.

P	Note:  Animations 
inside of movie clip 
symbols won’t play 
on the main timeline. 
Choose Control > 
Test Movie > in Flash 
Professional to preview 
nested animations.

P	Note:  Animations 
inside movie clip 
symbols will loop 
automatically. To 
prevent the looping, 
you need to add 
ActionScript to tell the 
movie clip Timeline to 
stop on its last frame. 
You’ll learn more about 
ActionScript in Lesson 6.
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1	 In the Left_car layer, select frame 101, which is the frame just after the second 
keyframe where the car ends its movement.

2	 Right-click/Ctrl-click on frame 101 and choose Split Motion.

Flash cuts the motion tween into two separate tween spans. The end of the first 
tween is identical to the beginning of the second tween.

Motion tween split

3	 In the Middle_car layer, select frame 94, and right-click/Ctrl-click and choose 
Split Motion.

Flash cuts the motion tween into two separate tween spans.

4	 In the Right_car layer, select frame 107, and right-click/Ctrl-click and choose 
Split Motion.

Flash cuts the motion tween into two separate tween spans. The motion tweens 
of all three cars are split.
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Setting eases of a motion tween
You’ll apply an ease-in to the motion tweens of the approaching cars to give them 
a sense of weight and decelerate as real cars would.

1	 In the Middle_car layer, select any frame between the first and second 
keyframes of the first motion tween (frame 70 to frame 93).

2	 In the Properties inspector, enter 100 for the Ease value.

Flash applies an ease-out effect to the motion tween.

3	 In the Left_car layer, select any frame between the first and second keyframes 
of the first motion tween (frame 75 to frame 100).

4	 In the Properties inspector, enter 100 for the Ease value.

Flash applies an ease-out effect to the motion tween.

5	 In the Right_car layer, select any frame between the first and second keyframes 
of the first motion tween (frame 78 to frame 106).

6	 In the Properties inspector, enter 100 for the Ease value.

Flash applies an ease-out effect to the motion tween.
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7	 Enable the Loop Playback option at the bottom of the Timeline, and move the 
front and rear markers to bracket frames 60 to 115.

Front marker Back marker

Loop playback

8	 Click Play (Enter/Return).

Flash plays the Timeline in a loop between frames 60 to 115 so you can examine 
the ease-out motion of the three cars.

Frame-by-Frame Animation
Frame-by-frame animation refers to the illusion of movement created by seeing the 
incremental changes between every keyframe. It’s the closest to traditional hand-
drawn cel animation, and it’s just as tedious. In Flash, you can change a drawing in 
every keyframe, and create a frame-by-frame animation.

Frame-by-frame animations increase your file size rapidly because Flash has to 
store the contents for each keyframe. Use frame-by-frame animation sparingly.

In the next section, you’ll insert a frame-by-frame animation inside the carLeft 
movie clip symbol to make it move up and down in a jittery fashion. When the 
movie clip loops, the car will rumble slightly to simulate the idle of the motor.

Inserting a new keyframe
The frame-by-frame animations inside the carMiddle and carRight movie clip sym-
bols have already been done. You’ll finish the animation for the carLeft symbol.

1	 In the Library panel, double-click the carRight movie clip symbol to examine its 
completed frame-by-frame animation.

Inside the carRight movie clip, three keyframes 
establish three different positions for the car 
and its headlights. The keyframes are spaced 
unevenly to provide the unpredictable up and 
down motion.



Adobe Flash Professional CC Classroom in a Book  137

2	 In the Library panel, double-click the carLeft move clip symbol.

You enter symbol-editing mode for the carLeft symbol.

3	 Select frame 2 in both the lights layer and the smallRumble layer.

4	 Right-click/Ctrl-click and choose Insert Keyframe (F6).

Flash inserts a keyframe in frame 2 of the lights 
layer and the smallRumble layer. The contents 
of the previous keyframes are copied into the 
new keyframes.
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Changing the graphics
In the new keyframe, change the appearance of the contents to create the animation.

1	 In frame 2, select all three graphics on Stage (Edit > Select All, or  
Ctrl/Command+A) and move them down the Stage 1 pixel. You can  
use the Properties inspector or press the Down Arrow key to nudge the  
graphics by 1 pixel.

The car and its headlights move down slightly.

2	 Next, repeat the process of inserting keyframes and changing the graphics.  
For a random motion like an idling car, at least three keyframes are ideal.

3	 Select frame 4 in both the lights layer and the smallRumble layer.

4	 Right-click/Ctrl-click and choose Insert Keyframe (F6).

Flash inserts a keyframe in frame 4 of the lights 
layer and the smallRumble layer. The contents 
of the previous keyframes are copied into the 
new keyframes.

5	 Select all three graphics on Stage (Edit > Select All, or Ctrl/Command+A) and 
move them up the Stage 2 pixels. You can use the Properties inspector or press 
the Up arrow key twice to nudge the graphics by 2 pixels.

The car and its headlights move up slightly.

6	 Test the idling motion by enabling the Loop Playback option at the bottom 
of the Timeline and click Play (Enter/Return).

Animating 3D Motion
Finally, you’ll add a title and animate it in 3D space. Animating in 3D presents 
the added complication of a third (z) axis. When you choose the 3D Rotation or 
3D Translation tool, you need to be aware of the Global Transform option at the 
bottom of the Tools panel. The Global Transform option toggles between a global 
option (button depressed) and a local option (button raised). Moving an object 
with the global option on makes the trans-
formations relative to the global coordinate 
system, whereas moving an object with the 
local option on makes the transformations 
relative to itself.

1	 Click on Scene 1 in the Edit Bar to return 
to the main timeline, and insert a new 
layer at the top of the layer stack and 
rename it title.
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2	 Lock all the other layers.

3	 Insert a new keyframe at frame 120.

4	 Drag the movie clip symbol called movietitle from the Library panel onto the Stage.

The movie title instance appears in your new layer in the keyframe at frame 120.

5	 Position the title at x=180 and y=90.
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6	 Right-click/Ctrl-click on the movie title and choose Create Motion Tween.

Flash converts the current layer to a Tween layer so you can begin to animate 
the instance. 

7	 Move the red playhead to frame 140.

8	 Select the 3D Rotation tool.

9	 Deselect the Global Transform option at the 
bottom of the Tools panel.

10	Click and drag the title to rotate it around the 
y-axis (green) so that its angle is at about −50 
degrees. You can check the rotation values in the 
Transform panel (Window > Transform).

11	Move the red playhead to the first keyframe at frame 120.

12	Click and drag the title to rotate it around the y-axis in the opposite direction so 
that the instance looks like just a sliver.  

Flash motion-tweens the change in the 3D rotation, so the title appears to swing 
in three dimensions. 
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Testing Your Movie
You can quickly preview your animation by “scrubbing” the red playhead back and 
forth on the Timeline or by choosing Control > Play. You can also use the inte-
grated controller at the bottom of the Timeline.

However, to preview your animation as your audience will see it and to preview any 
nested animations within movie clip symbols, you should test your movie. Choose 
Control > Test Movie > in Flash Professional.

Flash exports a SWF file and saves it in the same location as your FLA file. The 
SWF file is the compressed, final Flash media that you would embed in an HTML 
page to play in a browser. Flash displays the SWF file in a new window with the 
exact Stage dimensions and plays your animation.

To exit Test Movie mode, click the Close window button. 

You can also preview your animation by choosing Control > Test Movie > in 
Browser, and Flash will export a SWF file and open it automatically in your 
default browser.

P	Note:  The exported 
SWF in Test Movie mode 
will loop automatically. 
To prevent the looping 
in Test Movie mode, 
choose Control > 
Loop to deselect the 
loop option.

P	Note:  If you’ve 
targeted a different 
publishing platform 
in the Publish Settings 
(such as Adobe AIR), 
those options will 
be available for you 
in the Control > Test 
Movie menu. 
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Generating PNG Sequences and Sprite Sheets
While you can create sophisticated animations to play as a SWF file with the 
Flash Player, you can also use Flash’s powerful tools to create your anima-
tion and export it as a series of images for use in other environments. For 
example, animations with HTML5 or on mobile devices often rely on sequen-
tial PNG files or a single file that packs all the images organized in rows and 
columns known as a sprite sheet. The sprite sheet is accompanied by a data 
file that describes the position of each image, or sprite, in the file.

Generating either PNG sequences or a sprite sheet of your animation is easy. 
First, your animation must be within a Movie Clip symbol. In the Library 
panel, right-click/Ctrl-click the symbol and choose Export PNG Sequence.

In the next steps, you select the destination on your hard drive for your 
images and the dimensions of your images.

For a sprite sheet, right-click/Ctrl-click the symbol and choose Generate 
sprite sheet. The Generate Sprite Sheet dialog box that appears provides 
different options such as sizing, background color, and the particular 
data format.

Click Export to output the sprite sheet and data file. The data file determines 
what kind of development environment you’ll use your sprite sheet in. For 
example, JSON, Starling, and cocos2D are some of the data formats available.
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Review Questions
1	 What are two requirements of a motion tween?

2	 What kinds of properties can a motion tween change?

3	 What are property keyframes, and why are they important?

4	 How can you edit the path of an object’s motion?

5	 What does easing do to a motion tween?

Review Answers
1	 A motion tween requires a symbol instance on the Stage and its own layer, which is 

called a Tween layer. No other tween or drawing object can exist on the Tween layer.

2 	 A motion tween creates smooth transitions between different keyframes of an object’s 
location, scale, rotation, transparency, brightness, tint, filter values, or 3D rotation 
or translation.

3	 A keyframe marks a change in one or more properties of an object. Keyframes are 
specific to each property, so that a motion tween can have keyframes for position that 
are different from keyframes for transparency. 

4	 To edit the path of an object’s motion, choose the Selection tool and click and drag 
directly on the path to bend it. You can also choose the Convert Anchor Point tool 
and Subselection tool to pull out handles at the anchor points. The handles control 
the curvature of the path.

5 	 Easing changes the rate of change in a motion tween. Without easing, a motion tween 
proceeds linearly, where the same amount of change happens over time. An ease-in 
makes an object begin its animation slowly, and an ease-out makes an object end its 
animation slowly.
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Index

Numbers

3D motion, animating, 138–140
3D position, changing for objects, 101
3D rotation, changing for objects, 99–101
3D Rotation tool, Global Transform 

option, 102
3D space, positioning in, 99–104
3D Translation tool, Global Transform 

option, 102

Symbols

* (asterisk), appearance with filename, 38
*/ and /* (comments), using in ActionScript 3.0, 

188
// (comments), using in ActionScript 3.0, 188
. (dot operator), using in ActionScript 3.0, 188
= (equals sign), using with variables, 295
() (parentheses), using in ActionScript 3.0, 188
" (quotation marks), using in 

ActionScript 3.0, 188, 198
; (semicolons), using in ActionScript 3.0, 188

A

ActionScript, support for, 11
ActionScript 3.0

Actions panel, 266
arguments, 187
Auto-fill options, 203
color hinting, 194
commands for Timeline navigation, 194
comments, 188
comments (//), 188
comments (*/ and /*), 188
comparing elements of, 266
curly brackets ({}), 194
debugging, 195
dot operator (.), 188
error checking, 195
event handlers for buttons, 192–195

functions, 187
gotoAndPlay(); command, 194, 208
gotoAndStop(); command, 194
and JavaScript, 328
keywords, 187
methods, 187
mouse events, 193
navigating Actions panel, 189
nextFrame(); command, 194
objects, 187
overview, 186
parentheses (()), 188
period (.) placement, 194
play(); command, 194
prevFrame(); command, 194
ProLoader object, 266–268
properties, 187
punctuation, 194
quotation marks ("), 188
scripting syntax, 188
scripting terminology, 186–187
semicolons (;), 188
stop(); command, 194
straight vs. curly quotes, 199
URLRequest object, 266–268
variable names, 186
variables, 186
void term, 193
writing scripts in Actions panel, 188

Adobe AIR Developer Center Web site, 356
Adobe AIR runtime, 335

downloading, 3, 343
features, 335

Adobe Application Manager, accessing for 
updates, 44

Adobe Authorized Training Centers, 7
Adobe Certification, 7
Adobe Color Picker

accessing, 32
Alpha percentage, 32
transparency level, 32
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Adobe Community Help Web site, 6
Adobe Creative Cloud, 1
Adobe Design Center Web site, 7
Adobe Developer Connection Web site, 7
Adobe Flash CC Help and Support Web 

site, 6
Adobe Flash Professional CC. See Flash 

Professional CC
Adobe Forums Web site, 6
Adobe Illustrator

copying artwork, 77
importing layers, 77
importing symbols, 77
pasting artwork, 77
using with Flash, 77

Adobe Labs Web site, 7
Adobe Marketplace & Exchange Web site, 7
Adobe Media Encoder. See also Flash video

adding video files to, 231–232
downloading QuickTime, 231
launching, 231
preferences, 232
Queue preferences, 232

Adobe Scout, using to test Flash content, 357
Adobe TV Web site, 6
AIR applications

creating, 343–348
installing, 343–348
quitting, 349

AIR Debug Launcher, using with mobile 
apps, 351–353

AIR Developer Center Web site, 356
Align panel, opening, 70
Alt key, using with control points, 51
Anchor option, using with Stage, 38
anchor points

adding, 63
deleting, 63

animating
3D motion, 138–140
cityscape, 110–112
colors, 161–162
filters, 118–121
Mask layer, 166–169
Masked layer, 166–169
mountains, 317–320
position, 110–113
shapes, 146
transformations, 122–125
transparency, 116–118

animations. See also movies; videos
adding titles to, 31–34
changing pacing of, 113–115
changing timing of, 113–115
creating, 11–12
creating inside movie clip symbols, 

131–133
explained, 109
frame by frame, 136–138
looping, 153–156
motion tweens, 109
nesting, 131–133
playing at destinations, 205–209
previewing, 36
previewing with Controller panel, 113
previewing with Onion Skin Outlines, 160
stopping, 208–209
transitions, 205–207
workflow, 109

Application Manager, accessing for 
updates, 44

asterisk (*), appearance with filename, 38
audio, preventing overlap in video, 249. See 

also sounds
audio options, setting for video, 240–242
Auto-Recovery, using for backup, 38–39

B

backup, using Auto-Recovery for, 38–39
bird animation project. See HTML5 project
bitmap art, converting vector art to, 60–61
bitmap fills, adding, 58
bitmap images

converting to vector graphics, 84
Export as Bitmap option, 97

Bitmap Properties dialog box, displaying, 29
blend types, 149
blending effect, using with Photoshop files, 

80–83
Blending options

Add, 96
Darken, 96
Difference, 96
Hard Light, 96
Lighten, 96
Normal, 96
Overlay, 96
Subtract, 96

blur filter, applying, 98
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Boolean data type, explained, 294
button instances

naming, 185
placing, 183–184

button symbols
creating, 175–179
Down state, 175
features of, 79
Hit state, 175
Over state, 175
Up state, 175

buttons
adding sounds to, 228–230
animating, 210–212
creating event handlers for, 192–195
duplicating, 180–181
invisible and Hit keyframe, 180
swapping, 181–182

C

camera image. See also images
creating mask for detail, 284–287
creating thumbnail of, 282
making invisible, 289–290
repositioning, 300–301
showing and hiding, 291–292

CC (Creative Cloud), 1
certification, finding out about, 7
Check project

loading external content, 266–271
movie clips, 274–275
overlapping content, 276
removing external content, 273
viewing, 264–265

cityscape
animating, 110–112
isolating, 112
making transparent, 116–118

classic tweens
exporting, 320
vs. motion tweens, 312

Classroom in a Book files, accessing, 5
Code Snippets panel

creating home button with, 200–202
loading external content, 270–271
options, 202–203
sharing code snippets, 204

codec, using with Flash video, 230

coffee cup
changing contours, 52
creating, 49
editing shapes, 51
fill of top oval, 53
Gradient Transform tool, 57–58
gradient transitions, 55–57
modifying, 50

Color Picker
accessing, 32
Alpha percentage, 32
transparency level, 32

colors, matching for objects, 67–68
Command key. See keyboard shortcuts
comments (//), using in ActionScript 3.0, 188
comments (*/ and /*), using in 

ActionScript 3.0, 188
Coney Island project

Auto-Recovery for backup, 38–39
content scaling, 37–38
creating document, 11–12
frames, 20–21
keyframes, 22–24
layers, 18–20, 24–27
Library panel, 15–17
panels, 30
previewing, 36
Properties inspector, 27–29
publishing, 41–43
resizing Stage, 37–38
saving, 38–41
Stage, 14–15
Timeline, 17–24
Tools panel, 30–34
undoing steps, 34–35
viewing, 10
workspace, 12–15
XFL documents, 39–41

content. See external content
control points

using Alt key with, 51
using Option key with, 51

Controller panel, previewing animations 
with, 113

copying
layers, 27
lesson files, 5
sample movies, 5
sample projects, 5
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corners, adding to shapes, 52
cropping video, 233–239
Ctrl key. See keyboard shortcuts
cue points, using in video encoding, 239
cursor, customizing, 302–306
curves

adding anchor points, 63
creating, 61–63
deleting anchor points, 63
editing, 63
Pen tool, 61–62

custom icon
disabling input for, 305–306
following mouse with, 302–305

D

data types
Boolean, 294
Number, 294
String, 294

debugging process, reviewing storyboard, 
333–334

deleting
anchor points, 63
fills, 50
layers, 20
shape hints, 160
sound files, 226
strokes, 50

desktop application, publishing, 343–349
destination keyframes. See also keyframes; 

property keyframes
frame labels, 198–199
inserting, 195–197
straight quotes (‘), 199

display options
blending effects, 96
visible property for movie clips, 95–96

documents, creating, 11–12. See also 
XFL documents

dot operator (.), using in ActionScript 3.0, 188
Double Identity project

adding frames, 115
animating 3D motion, 138–140
animating filters, 118–121
animating position, 110–113
animating transformations, 122–125
animating transparency, 116–118

animation duration, 113–115
described, 109–110
easing, 133–136
frame-based selections, 116
frame-by-frame animation, 136–138
motion presets, 125
moving keyframes, 115
nesting animations, 131–133
pacing, 113–115
path of motion, 126–129
PNG sequences, 142
previewing animation, 113–114
property keyframes, 121
span-based selections, 116
sprite sheets, 142
swapping tween targets, 129–130
testing, 141
timing, 113–115
viewing, 108

drawing modes
Merge, 54
Object, 54
Primitive, 54

E

EaselJS commands, documentation for, 324
EaselJS library, described, 311
eases of motion tweens, setting, 135–136
easing

explained, 133
shape tween, 169–170
splitting motion tweens, 133–134

Edit bar, identifying, 12
educators, resources for, 7
embedded video, using, 253–256
equals sign (=), using with variables, 295
event handlers for buttons

checking for errors, 195
event listener and function, 192–194

event handling, process of, 192
event listeners

adding for buttons, 192–195
adding for mouse click, 326–327
adding for mouseout, 290–291
adding for mouseover, 290–291
adding to movie clips, 268–269

events, defined, 192
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exporting
classic tweens, 320
to HTML5, 321–324
to JavaScript, 321–324
video from Flash, 256–260

external content
ActionScript objects, 266–268
Code Snippets panel, 270–271
loading, 266–271
managing overlapping, 276
positioning after loading, 272
ProLoader object, 266–268
removing, 273
removing sounds from, 273
URLRequest object, 266–268

external video. See also videos
FLVPlayback component, 245–246
playing back, 242–246
skins, 243–244
testing, 245

Eyedropper tool, using, 67–68

F

F4V format, using with video, 230
files for Classroom in a Book, accessing, 5
fills

changing, 53
deleting, 50
described, 48, 55
deselecting on Stage, 56
modifying alpha values of, 64–65
selecting, 50

filter options
Blur, 98
Copy, 99
Disable Filter button, 99
Enable Filter button, 99
Paste, 99
Reset Filter button, 99
Save as preset, 99

filters, animating, 118–121
Fire Starter project

animating color, 161–162
animating Mask layer, 166–169
animating Masked layer, 166–169
animating shapes, 146
blend types, 149
broken tweens, 153

changing pace, 150
contents of project file, 147
easing shape tween, 169–170
looping animation, 153–156
masks, 163–165
shape hints, 156–160
shape tweens, 147–153
viewing, 146

flame
flickering, 153
morphing, 148–149

Flash, starting, 10
Flash content, testing through Adobe Scout, 

357
Flash interface, changing shade of gray, 14
Flash movies, controlling, 343
Flash Player, detecting version of, 339–340
Flash Professional CC

feature set, 2–3
features, 1
installing, 4
new features, 2
prerequisites, 3

Flash Support Center, accessing, 44
Flash video. See also Adobe Media Encoder; 

videos
codec, 230
converting video files to, 232–233
embedding, 250–256
F4V standard, 230
FLV standard, 230
H.264 standard, 230
options, 230
playback, 230

FLV format
embedding on Timeline, 252–253
encoding for embedding, 250–251
hearing audio for, 253
using with video, 230

FLVPlayback component
autoPlay option, 246
changing video files, 246
choosing files to play, 246
Content Path dialog box, 246
controller, 246
moving video files, 246
skin color, 246
skin transparency, 246
using with video, 245–246
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frame cell rows
changing width of, 27
decreasing height of, 26

frame information, reading in Timeline, 17
frame-by-frame animation, 136–138
frames

adding to motion tweens, 115
inserting into Timeline, 20–21
and keyframes, 23
selecting in Timeline, 21

Free Transform tool, using, 51
function, adding for button, 192–195
function keys. See also keyboard shortcuts

Convert to Symbol command, 297
toggling panels, 14

G

Garden Court Cafe project
adding hyperlinks, 68–69
aligning objects, 69–70
bitmap fills, 58
changing fills, 53
changing shape contours, 52
changing strokes, 53
creating curves, 61–63
creating shapes, 49–50
creating text, 66–69
creating transparencies, 64–66
custom line styles, 59–61
distributing, 69–70
editing shapes, 51–53
editing text, 66–69
fills, 48
gradient fills, 55–58
grouping objects, 59
matching colors for objects, 67–68
selections, 50
strokes, 48
viewing, 48

gradient fills, adjusting, 161–162
Gradient Transform tool
gradient transitions

creating, 55–57
Lock Fill option, 57

gradients
described, 55
linear, 55
radial, 55

graphic symbols, features of, 79
grouping objects, 59
groups, ungrouping, 59
guides, using with symbol instances, 92–93

H

H.264 standard, using with Flash video, 230
History panel

accessing, 34–35
removing steps in, 35

Hit keyframe, using with invisible buttons, 
180

home button, creating with code snippets, 
200–202

HTML files, creating for movies, 41–43
HTML5

exporting to, 321–324
output files, 322
publish settings, 323–324

HTML5 project
adding tail feathers, 313–314
animating mountains, 317–320
applying classic tween, 315–316
changing feature instance, 314–315
classic tweens, 312
inserting keyframes, 314
Toolkit for CreateJS, 311–312
viewing, 310–311

hyperlinks, adding, 68–69

I

Illustrator
copying artwork, 77
importing layers, 77
importing symbols, 77
pasting artwork, 77
using with Flash, 77

Illustrator files, importing, 75–76
image formats, support for, 84
images. See also camera image

smoothing, 29
using after importing, 17

imported images, using, 17
importing

Illustrator files, 75–76
JPEG images into library, 16
Photoshop files, 80–83
sound files, 218–219
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Ink Bottle tool, using, 53
installing

AIR application, 343–348
Flash Professional, 4

instances, naming rules, 185
interactive movies, 175
iOS Simulator, obtaining, 350

J

JavaScript
and ActionScript, 328
code blocks, 324
event listener for mouse click, 326–327
exporting to, 321–324
inserting, 324–327
output files, 322
publish settings, 323–324
stopping playhead, 324–326

JavaScript open source libraries
EaselJS, 311, 324
SoundJS, 311
TweenJS, 311

JavaScript project
adding tail feathers, 313–314
animating mountains, 317–320
applying classic tween, 315–316
changing feature instance, 314–315
classic tweens, 312
inserting keyframes, 314
Toolkit for CreateJS, 311–312
viewing, 310–311

JPEG images, importing into library, 16

K

keyboard shortcuts. See also function keys
Actions panel, 266
Clear Keyframe, 24
Copy command, 51
Lock Guides, 93
Paste in Center command, 51
previewing movies, 333
Properties inspector, 28
Rulers, 92
Select All, 138
undoing steps, 34–35
ungrouping shapes, 59

keyframes. See also destination keyframes; 
property keyframes

creating, 22–23
destination, 195–199
distributing in tweens, 114
establishing for shapes, 147–148
and frames, 23
identifying, 22
inserting in HTML5 project, 314
moving, 24, 115, 150
removing, 24

L

large image. See camera image
layer folders

adding layers to, 26
collapsing, 26
creating, 25–26

layers. See also Timeline
adding to Timeline, 18–20
cutting, 27
deleting, 20
duplicating, 27
identifying, 12
modifying into Masked layers, 164
organizing in Timeline, 24–27
pasting, 27
rearranging, 20
renaming in Timeline, 18
in Timeline, 18

lesson files
copying, 5
using, 6

Library panel
accessing, 15
adding items to Stage, 17
described, 15
features, 16
importing items to, 16

line styles
controlling, 60
customizing, 59–61
decorative, 59–60

linear gradient, explained, 55
looping animations

duplicating keyframes, 154
inserting into movie clips, 155–156
Loop Playback option, 154
previewing loops, 154–155
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M

Mac OS, installing Flash Professional on, 4
Mask layer

animating, 166–169
defining, 163–164
seeing effects of, 165

Masked layer
animating, 166–169
creating, 164

masking, explained, 163
masks, traditional, 165
MechWars project

3D positioning of objects, 101
3D rotation of objects, 99–101
adding folders, 85
blending effects, 96
blur filter, 98
breaking apart symbol instances, 89–90
brightness, 94
button symbols, 79
color effect of instances, 93–95
creating symbols, 79–80
display options, 95–97
editing symbols, 86–89
filter options, 99
global vs. local transformations, 102
graphic symbols, 79
guides, 90–93
importing Illustrator files, 75–77
importing Photoshop files, 80–83
importing symbols, 77
movie clip symbols, 78
organizing libraries, 85
perspective angle, 103–104
repositioning symbol instances, 90–93
resetting transformations, 102–103
resizing symbol instances, 90–93
rulers and guides, 92–93
transformations, 102–103
transparency, 94–95
vanishing point, 103–104
viewing, 74

Media Encoder. See also Flash video
adding video files to, 231–232
downloading QuickTime, 231
launching, 231
preferences, 232
Queue preferences, 232

Merge Drawing mode, explained, 54
Meridien banner project. See also 

Restaurant Guide project
changing display settings, 340–342
viewing, 332–333

mobile apps
AIR Debug Launcher, 351–353
deployment, 355
graphics, 356
icons, 356
iOS Simulator, 350
languages, 356
publishing, 354–356
SimController, 351–353
simulating, 351–353
testing, 350

morphing
defined, 145
flame, 148–149

Motion Presets panel, using, 125, 207
motion tweens. See also tween targets

adding frames to, 115
vs. classic tweens, 312
explained, 109
removing, 112
saving and reapplying, 207
setting eases of, 135–136
splitting, 133–134
Tween layers, 109

mountains, animating, 317–320
mouse cursor

hiding, 305
showing, 305

mouse events in ActionScript, 193
mouse movements, mapping to visual 

changes, 293
mouseout, adding event listener for, 

290–291
mouseover, adding event listener for, 

290–291
movie clip instance, naming, 289
movie clip symbols

creating animations in, 131–133
features of, 78
using to animate buttons, 210–212
visible property, 95–96
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movie clips
adding event listeners to, 268–269
alpha property, 288
controlling, 274–275
data types, 288
height property, 288
name properties, 288
properties, 288
read-only, 288
rotation property, 288
scaleX property, 288
scaleY property, 288
visible property, 288
visual properties of, 287–290
width property, 288
x property, 288
y property, 288

movie samples, copying, 5
movies. See also animations; videos

creating HTML files, 41–43
creating SWF files, 41–43
interactive, 175
previewing, 36, 333
publishing, 41–43
saving, 38–41

moving keyframes, 24

N

nested animations, creating, 131–133
Number data type, explained, 294

O

Object Drawing mode, explained, 54
objects

aligning, 69–70
grouping, 59

Onion Skin Outlines, using with 
animations, 160

Option key, using with control points, 51
Output panel, sending information to, 296
Oval tool, using, 49–50

P

pacing of animations, changing, 113–115
Paint Bucket tool, using, 53
panel groups, moving, 30

panels
described, 9
displaying as icons, 30
docking, 30
grouping, 30
moving, 30
opening, 30
toggling, 14
undocking, 30

parentheses [( )], using in ActionScript 3.0, 
188

Paste in Center command, using with 
shapes, 51

path of motion
changing rotation of path, 127
changing scale of path, 127
editing, 128
manipulating directly, 128
moving, 126
orienting objects to, 129

Pen tool, using for curves, 61–62
perspective angle, explained, 103–104
photo layers, adding to photo folder, 26
Photoshop files

editing, 83
importing, 80–83

Play option, accessing, 141
PNG sequences, generating, 142
previewing

animations, 36
movies, 36, 333

Primitive Drawing mode, explained, 54
project samples, copying, 5
ProLoader objects

overlapping, 276
positioning, 272
removing from Stage, 273
unloading content from, 273
using with external content, 266–268

Properties inspector
features, 27
identifying, 12
opening, 28
positioning objects on Stage, 28–29

property keyframes, 121. See also keyframes
Publish Cache, clearing, 334
publish settings, changing, 333
Publish Settings dialog box, displaying, 336
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publishing
desktop application, 343–349
mobile apps, 354–356
for mobile device, 350–356
process of, 335

publishing for Web
Bitmap properties dialog box, 338
changing display settings, 340–342
Enable detailed telemetry option, 338
Flash file settings, 336–339
Flash Player version, 339–340
HTML Wrapper format, 338
playback settings, 343
requirements, 335
template options, 339

Q

QuickTime software, downloading, 
3, 231, 258

quotation marks ("), using in 
ActionScript 3.0, 188, 198

quotes, using with label names, 199

R

radial gradient, explained, 55
Rectangle tool, using, 49
registration point

coordinate space, 302
setting, 302

renaming layers in Timeline, 18
resources. See also Web sites

Adobe Community Help, 6
Adobe Design Center, 7
Adobe Developer Connection, 7
Adobe Flash CC Help and Support, 6
Adobe Forums, 6
Adobe Labs, 7
Adobe Marketplace & Exchange, 7
Adobe TV, 6
for educators, 7
finding for using Flash, 44

Restaurant Guide project. See also Meridien 
banner project

ActionScript 3.0, 186–189
adding stop action, 191
animated buttons, 210–212
animation at destination, 205–209

button symbol, 175–179
Code Snippets options, 202–204
destination keyframes, 195–199
duplicating buttons, 180–181
event handlers for buttons, 192–195
Hit keyframe, 180
home button with Code Snippets, 

200–202
interactive movies, 175
invisible buttons, 180
naming button instances, 185
placing button instances, 183–184
swapping buttons, 181–182
Timeline, 190
viewing, 174–175

Rulers keyboard shortcut, 92
runtime environments

Adobe AIR, 335
Flash Player, 335

S

saving
advanced audio options, 241–242
advanced video options, 241–242
movies, 38–41
workspace, 13–14
XFL documents, 39–40

Scout, using to test Flash content, 357
Select All keyboard shortcut, 138
Selection tool, editing curves with, 63
selections

fills, 50
making, 50
span-based vs. frame-based, 116
strokes, 50

semicolon (;), using in ActionScript 3.0, 188
shadows, using with transparent fills, 65–66
shape contours, changing, 52
shape hints

adding, 157–160
features, 156
guideline, 159
maximum number, 159
placement, 157
removing, 160
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shape tweens. See also tweens
Angular option for Blend, 149
applying, 148–149
broken, 153
creating, 147–149
Distributive option for Blend, 149
easing, 169–170
extending, 152–153
inserting keyframes, 150–152
keyframes, 147–148
modifying, 149
using to animate colors, 162

shapes
adding corners to, 52
animating, 146
Copy command, 51
editing, 51–53
Free Transform tool, 51
Oval tool, 49–50
Paste command, 51
Rectangle tool, 49

Shearwood Wildlife Preserve project
adding frames to Timeline, 221–222
adding sounds to buttons, 228–230
changing sound file, 226
changing volume of sound, 224–225
clipping end of sound, 222–223
cue points, 239
deleting sound file, 226
embedding Flash video, 250–256
encoding options, 234–242
exporting video from Flash, 256–260
Flash Video, 230
importing sound files, 218–219
Media Encoder, 231–234
placing sounds on Timeline, 220–221
playback of external video, 242–246
project file, 217–218
setting sound quality, 226–228
sound sync options, 230
video and transparency, 247–249
viewing, 216–217

Shift key. See keyboard shortcuts
SimController, using with mobile apps, 

351–353
skins

changing transparency of, 246
using with external video, 243–244

smoothing images, 29

sound files
changing, 226
deleting, 226
importing, 218–219

sound quality
Bit rate option, 228
setting, 226–228

sound sync options
Event, 230
Start, 230
Stop, 230
Stream, 230

sound volume, changing, 224–225
SoundJS library, described, 311
sounds. See also audio

adding frames to Timeline, 221–222
adding to buttons, 228–230
clipping ends of, 222–223
Edit Envelope dialog box, 222–223
placing on Timeline, 220–221
removing from external content, 273

sprite sheets, generating, 142
Stage

Anchor option, 38
Background color button, 15
choosing dimensions of, 11
content scaling, 37–38
described, 9
identifying, 12
positioning objects on, 28–29
resizing, 37–38
toggling viewing modes, 14

Stage dimensions, changing, 15
Stage properties, changing, 14–15
starting Flash, 10
steps

adding back, 35
undoing, 34–35

stop action, adding, 191
stopping animations, 208–209
storyboard, reviewing, 333–334
String data type, explained, 294
strokes

changing, 53
changing colors of, 53
deleting, 50
described, 48
selecting, 50

Subselection tool, editing curves with, 63
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SWF files
creating for movies, 41–43
explained, 36
publishing for Web, 336–339

symbol instances
breaking apart, 89–90
brightness options, 94
color effects, 93–95
guides, 92–93
repositioning, 90–92
resizing, 90–92
rulers, 92–93
transparency options, 94–95

symbols
adding folders, 85
buttons, 78–79
as containers, 78
Convert to Symbol command, 79
creating, 79–80
described, 73, 78
duplicating in Library, 87
editing from Library, 86
editing in place, 87–89
graphics, 78–79
movie clips, 78–79
organizing libraries, 85
storing, 78

system requirements, getting updates on, 4

T

Test Movie option
Coney Island project, 36
Double Identity project, 141

text
creating, 66–69
editing, 66–69

Text tool
exiting, 33, 67
using, 31–34, 66–67

Timeline. See also layers
adding layers to, 18–20
changing appearance of, 26–27
creating keyframes, 22–23
creating layer folders, 25–26
described, 9
frame information, 17
inserting frames in, 20–21
layers in, 18

locating, 12, 17
moving keyframes, 24
organizing layers in, 24–27
preparing, 190
Preview options, 26
rearranging layers in, 20
removing keyframes, 24
renaming layers in, 18
selecting frames, 21
Short option for layers, 26

timing of animations, changing, 113–115
titles

adding to animations, 31–34
animating in 3D space, 138–140

Toolkit for CreateJS
accessing, 321
EaselJS library, 311
feature compatibility warnings, 328
features, 311–312
SoundJS library, 311
TweenJS library, 311
updates, 312

tools
selecting, 31–34
using, 31–34

Tools panel
3D Rotation tool, 102
3D Translation tool, 102
Add Anchor Point tool, 63
Delete Anchor Point tool, 63
described, 30
drawing tools, 31
editing tools, 31
Eyedropper tool, 67–68
Free Transform tool, 51
identifying, 12
Ink Bottle tool, 53
interface, 31
options tools, 31
Paint Bucket tool, 53
Pen tool, 61–62
Selection tool, 63
selection tools, 31
Subselection tool, 63
Text tool, 66–67
transformation tools, 31
using, 30

trace() statement, using with Output 
panel, 296–297
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training centers, contacting, 7
transformations

animating, 122–125
global, 102
local, 102
resetting, 102–103

transition animations, creating, 205–207
transparencies

adding shadows, 65–66
animating, 116–118
creating, 64–66
modifying alpha value of fill, 64–65

Tween layers, explained, 109
tween targets, swapping, 129–130. See also 

motion tweens
TweenJS library, described, 311
tweens, distributing keyframes in, 114. See 

also shape tweens

U

undoing steps, 34–35
updates

checking for, 44
setting preferences for, 44

URLRequest object, using with external 
content, 266–268

V

vanishing point, explained, 103–104
variables

assigning values to, 295–296
creating, 293–294
creating for camera image, 297–300
strictly typed, 294
tracking in Output panel, 296–297
using equals sign (=) with, 295

vector art, converting to bitmap art, 60–61
vector graphics, converting bitmap images 

to, 84
video encoding

adjusting length, 238–239
advanced options, 240–242
audio options, 240–242
cropping video, 233–239
cue points, 239
Export Settings dialog box, 234–235

video files
adding to Media Encoder, 231–232
changing status in Queue, 233
converting to Flash video, 232–233

video playback, controlling, 246
videos. See also animations; external video; 

Flash video; movies
channels, 247
embedded, 253–256
exporting from Flash, 256–260
Output settings, 234
preset browser settings, 234
preventing overlapping audio, 249
processing in Watch Folders panel, 234
and transparency, 246–249

visible property, changing for camera 
image, 289–290

W

Watch Folders panel, using with videos, 234
Web publishing

Bitmap properties dialog box, 338
changing display settings, 340–342
Enable detailed telemetry option, 338
Flash file settings, 336–339
Flash Player version, 339–340
HTML Wrapper format, 338
playback settings, 343
requirements, 335
template options, 339

Web sites. See also resources
Adobe AIR Developer Center, 356
Adobe AIR runtime, 3, 343
Adobe Certified programs, 7
AIR Developer Center, 356
Flash Professional installation, 4
QuickTime software, 3, 231, 258
system-requirement updates, 4
Toolkit for CreateJS updates, 312

Windows, installing Flash Professional on, 4
workspace

choosing, 13
Edit bar, 12
layers, 12
Properties inspector, 12
saving, 13–14
Stage, 12
Timeline, 12
Tools panel, 12
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X

XFL documents. See also documents
modifying, 40–41
saving, 39–40

Z

Zonny DSLR Camera project
creating variables, 293–294, 297–300
custom cursor, 302–306
data types, 294
event listener for mouseout, 290–291
event listener for mouseover, 290–291
graphics setup, 282–284
hiding large image, 291–292
making image invisible, 289–290
mapping mouse movements, 293
mask for camera detail, 284–287
naming movie clip instances, 289
project file, 281–282
registration point, 302
repositioning large image, 300–301
showing large image, 291–292
text setup, 282–284
tracking variables, 296–297
values for variables, 295–296
viewing, 280–281
visual properties of movie clips, 287–288
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